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I know how to select and 

run a Simulation configuration

in the Code Generator toolbar

Simulation: I Know!!!

I know how to assign values/observe 

to the model’s inputs/outputs and 

run cycles during the simulation



4 © 2016 ANSYS, Inc. February 1, 2017 ANSYS Confidential

Is it possible to use test 

scenarii?

How to use the simulator to 

debug a SCADE Suite 

design?

What Else?
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Set Input Values By Scenario Files

4 formats:
o State scenario (.sts), binary file

o Input vector values file (.in)

o TCL script file (.sss)

o Snapshot scenario (.sns)

State scenario (.sts), binary file
• Store the state of SCADE Suite Simulator at any given step of a 

simulation session



6 © 2016 ANSYS, Inc. February 1, 2017 ANSYS Confidential

Set Input Values By Scenario Files

Input vector values file (.in)

Simulator script file (.sss)

Input Start Input Stop

One line= one cycle
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Producing Code for Testing on External Platforms

Snapshot scenario (.sns)
o Textual file that stores the SCADE application state: input/output 

values, memories, sensors, and cycle number

o Outcome of a recorded sequence

o Allows speeding up testing execution

o Save/load application states for external test environments

o Such snapshots can be reused by 

• SCADE Simulator and 

• SCADE Test depending on KCG options and generated code

‒ Used as Preamble, initializes the application to a particular state 
before running the actual test scenarios

‒ During the Preamble, neither coverage measurement nor output 
checks are performed
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Producing Code for Testing on External Platforms

Support of System (Closed-loop)
o Coverage measures can be stored from System Testing environment 

to SCADE Test Model Coverage 

o Storage of the Application state in a Snapshot scenario is performed 
in the external testing environment, using the SCADE Test Services 
API

o Coverage measurement is loaded and reported in the SCADE Test 
Environment
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Producing Code for Testing on External Platforms

Must generate code depending on model and code 
generation options to produce an API whose functions can 
save/load snapshots

o Set “Test Services API” adaptor in Code Generator settings (Code 
Integration tab)

o The API is made of the following files: 

<ProjectName>_snapshot.h and 
<ProjectName>_snapshot.c

o These files can be embedded in an 

external test environment and the 

main functions of the API allow to 

save/load application states in 

snapshots
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Managing Scenario Files in Simulation

Save, load, unload files using the toolbar buttons                          
or using the menu: Simulation > Scenario

o Save   : save the input history of the current simulation 
execution in a file (.in, .sss, .sts, .sns)

o Users can select from which cycle you want to save a scenario. By 
default it is from the first cycle
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Managing Scenario Files in Simulation 

Load : unload the previous file (if any), load a file, and 
simulate from the loaded file:

o When loading a state scenario, the simulator is reset

o Otherwise, the simulation continues from the current cycle

Unload : unload the current scenario file (.in or .sss). 
o When a scenario is loaded, the input values cannot be changed 

manually
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Simulator Script Scenario Files

Simulation-dedicated TCL commands:
o SSM::<command>

o With <command> =  an instruction

o List of main instructions:
set, get, cycle, check, uncheck, set_tolerance, default_inputs, 
get_obs_list, random_inputs

A SSS scenario can drive and observe the simulation, by 
giving values to the inputs and getting back the values of the 
outputs.

See details in Simulator Technical Document
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Simulator Script Scenario Files
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How to save the values of 

the outputs during a 

scenario execution?
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Output Files

Save all inputs/outputs and selected observable variables 
computed during the simulation session.

First, select the output file and the observability file:

• Output File: This type of file contains input 
and output values from your simulation 
sessions. 
File format is “.out“ or “.csv”

• Observability File: This type of file specifies a 
list of observable variables added in the output 
file at each simulation cycle. 
File format is “.obs”.
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Output Files

From Simulation menu, select “Save To” item and set the 
output file name

Then, start or stop recording the values in the selected 
output file from the selected cycle
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Output Files

Two output formats are available:
o a textual output file (.out) giving all values for each executed cycle

o a csv format file, which can be directly imported into Excel
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Probes

Defines a new variable to associate with one flow:

Enhance observation by allowing the watch of any internal 
flow during the simulation or execution of the generated 
code.
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Format of OBS Files

Each line must provide the path of variable. If this path 
contains any space, it has to be surrounded by quotes. 

o Variable at top level

o Variable in an instantiated and iterated operator

o Variable in a state machine

"ABC_N::ABC_N/ABC_N::Button 

4[1]/StateMachine1:Preselected:_L3"

"ABC_N::ABC_N/ABC_N::Button 4[0]/foreground"

ABC_N::ABC_N/lockFall
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Format of OBS Files

All characters included between the first character following 
the last quote or the first space, and the end of the line are 
considered as a comment:

ABC_N::ABC_N/Lock this is a comment
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Format of OBS Files

Automatically generate an OBS file from the Watch window

Import an OBS file to the Watch Window
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How to use Breakpoints 

and Stop Conditions in the 

Simulator?
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Breakpoints and Stop Conditions

Break points and stop conditions help users to reach specific 
situations during a simulation.

You have to start the simulation to be able to set 
breakpoints.

Each time a breakpoint or a stop condition is reached during 
one cycle, the simulation pauses and the breakpoint owner 
turns red.



24 © 2016 ANSYS, Inc. February 1, 2017 ANSYS Confidential

Breakpoints on State Machines

Right click on a state or a transition, on canvas or in the 
instance tree to set, disable or remove breakpoints.

true

1

Breakpoint on a 
transition

Breakpoint set

Setting a breakpoint
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Breakpoints on Dataflow

Right click on a flow and insert a breakpoint. 

Users can stop:
o When the value of the flow changes

o When the value is =, !=, >, <, <=  or >= with a user defined value
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Advanced Breakpoints : Stop Conditions

Stop conditions are used if a more complex expression is 
needed for a breakpoint:

o During simulation, menu: 
Simulation – Breakpoints (Alt-F9)

o Click on Advanced tab

o Give a name to your 
advanced breakpoint

o Type the TCL expression

o Click on Add

Each time a breakpoint or a stop condition is reached during 
one cycle, a message occurs:
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Assume & Guarantee

Assume and Guarantee are SCADE Suite constructs defining 
Boolean expressions that can be attached to operators:

o Expressions used in assume can only mention input identifiers or 
past variables. No such restriction is imposed for guarantee
expression

o An assertion is well typed if the associated expression is of Boolean 
type

These conditions form the contract of the operator with 
respect to its environment:

o Safer control during simulation or execution

o Proof objectives for formal verification
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Scade Contracts

Characterized by a pair of observers:
o Assume: observes inputs and the past of the outputs

o Guarantee: observes inputs and outputs

Adds information about the environment into the SCADE 
Suite model

Accelerates tests and proofs by restricting the domains of the 
inputs
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Scade Contracts

node N (A:int;B:int)

returns (C:int)

let

assume PreCond: A > B;

guarantee PostCond: C > 0;

C = 10 * ( A - B ) ;

tel ;

AA

BB

CC

10

PreCondition: A > B

PostCondition: C > 0
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Assume & Guarantee

Assume and Guarantee clauses can be used to stop the simulation when 
they are violated.

Stop on assertions should be selected before:

Select Tools  > Options, then on Simulator tab set “Stop simulation” in 
Run-Time Events

Assertions must be inserted into the equation blocks before the 
simulation.
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Exercise 1: Cruise Control

Open Day4/Prerequisite/Exercise 1/CruiseControl.etp project

Create a new Guarantee on the output cruiseSpeed of CruiseControl 
node:

𝑐𝑟𝑢𝑖𝑠𝑒𝑆𝑝𝑒𝑒𝑑 ≤ 130.0

Configure the simulator to stop the simulation on failed check/assertion

Open the simulation and run Day 4\Solution\Exercise 
1\Scenarios\CruiseSpeedTest.sss scenario file

Observe the inputs/outputs value when the assertion has failed

Time: 10 min
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Exercise 1: Cruise Control

Change the guarantee according to the requirements:

𝑐𝑟𝑢𝑖𝑠𝑒𝑆𝑝𝑒𝑒𝑑 ≤ 150.0

Open the simulation and run Day 4\Solution\Exercise 
1\Scenarios\CruiseSpeedTest.sss scenario file

CC_HLR_CSM_05
The Cruise Speed shall 

be maintained between 
SpeedMin and SpeedMax 

km/h values.

CC_HLR_CCP_01
SpeedMin: shall be 30.0 Km/h

CC_HLR_CCP_02
SpeedMax: shall be 150.0 Km/h
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I know how to set KCG options

Generated Code: I Know!!!

I know how to generate code
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Configuration Options (C Code)
Generate context as global
(-global_root_context )

o Modifies the global data types and 
architecture of execution of the 
generated C code. Inputs and context 
variables are not passed as arguments 
to root functions but as global C variables

Wrap C operators 
(-wrap_c_ops)

o Encapsulates arithmetic, binary and relational operators into C protected 
macros (see SCADE Technical Manual for the complete operators list)

Keep assertions 
(-keep_asserts)

o If this option is set, a call is performed on user-defined macros named 
kcg_assume (resp. kcg_guarantee) for each assume (resp. guarantee) 
equation in the input model
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Configuration Options (C Code)

Keep probes in generated code 
(-probes)

o All C variables corresponding to probes 
in the input model are kept in the 
contexts corresponding to node calls

Generate system memory state management 
(-state_vector)

o Generates the state vector structure and function prototypes in the 
header files of the root operator and of dependent operators
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Configuration Options (C Code)
Short circuit operators 
(-short_circuit)

o Forces the use of short circuit operators 
(&& and ||) instead of bitwise operators

Name length 
(-name_length <nlength>)

o Limits the length of the name of 
generated identifiers to <nlength> 
characters

Significance length 
(-significance_length <slength>)

o Allows to differentiate two generated identifiers on their first 
<slength> characters



38 © 2016 ANSYS, Inc. February 1, 2017 ANSYS Confidential

Configuration Options (C Code)

Global prefix 
(-globals_prefix <prefix>)

o All global names are prefixed 
by the <prefix> string

User config 
(-user_config <filename>)

o Includes the header file <filename> 
at the beginning of the generated file 
kcg_types.h

Header file 
(-header <filename>)

o Adds the content of the file <filename> at the beginning of each 
generated file. <filename>  should only contain valid C comments
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Configuration Options (Ada)

Keep assertions
(-keep_asserts)

o Translates assume and guarantee 

constructs using procedure calls 

o Users must provide all procedure 

definitions in kcg_config.ads/adb files

Short circuit operators 
(-short_circuit)

o Forces the use of short circuit 
operators (&& and ||) instead of 
bitwise operators

Keep probes in generated code 
(-probes)
• All variables corresponding to probes in the input model are kept in the contexts 

corresponding to node calls

Ada
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Configuration Options (Ada)
Top-level package 
(-root_package <path>)

o Specifies an Ada valid path where all Ada 
code is generated

Top-level imported package 
(-imported_root_package <path>)

o Specifies an Ada valid path where all Ada 
imported code must be provided by 
users

Header file
(-header <filename>) 
• Browses for files and specifies a file whose content is added at the beginning of each 

generated file before the banner generated by Code Generator

Use type clauses (-use_types <list>)
• For each checked predefined type, a “use type” clause is generated in the Ada code 

when needed

Ada
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Separate I/Os Options
All
(-separate_io_all) 

o To mark all operators for separate I/Os

Selected
(-separate_io <pathlist>)

o To define the list of operators (checked)
marked for separate I/Os with respect
to the usage of pragmas or not
All except selected
(-no_separate_io <pathlist>)

o To define the list of operators (checked) not marked for separate I/Os with 
respect to the usage of pragmas or not

List of operators marked for separate I/Os: 
Generated cyclic function of selected operator is different for I/Os:

o Outputs are passed as separate parameters
o Inputs are no more passed in input context for the root operator
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Exercise 2: Cruise Control

Generate KCG code with different options and observe the 
generated files:

C code:
A global prefix,

Generate context as global,

…

Ada code: 
Top-level package 

Use Type clause

….

Time: 10 min
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Fixed-Point Representation
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I know how to integrate a SCADE Suite 

generated function in its environment

Integration: I Know!!!

call the generated initialization function

begin_loop

wait for an event (usually a clock signal)

treat the inputs

call the generated cyclic function

treat the outputs

end_loop
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Where are the SCADE 

Suite types defined?

How to modify the SCADE Suite 

predefined types?

What are the integration options 

proposed by SCADE Suite?

What Else?
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C Code: kcg_types.c/h

Contains C code related to the types defined in the input 
model:

kcg_types.h contains:
• Definition of all predefined types
• Definition of boolean constants
• Definition of assignment macros
• Definition of enumerated types
• Definition of structured types, 

and copy/compare functions
• …

kcg_types.c contains:
• Definition for each structure 

comparison function
• Definition for each array 

comparison function
• …
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C Generated Code: kcg_types.h

Predefined types
Enum types

…

Assignment macros
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How to Modify Predefined SCADE Suite Types 
(C Code)
Use the –user_config KCG option to set a user configuration file 
containing macro definition.

User_macro.h define int16 type:
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How to Modify Assignment Macros? (C Code)

kcg_assign macro determines “memcpy”:

The kcg_assign macro must be provided by one of the 
following means:

o -user_config option mechanism

o kcg_assign.h file

kcg_assign.h header file must be provided by the user
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C Code: kcg_assign.h

Find an example in <install_dir>\SCADE\include
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KCG_COPY Macro  (C Code)

A copy function is a two-parameters macro generated to 
copy an object of a structured type (structure and array) into 
another object of the same type 

Both parameters are given by reference
o The first parameter is the target and the second is the source
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KCG_COPY Macro  (C Code)

kcg_types.h file contains a copy function:
o For each structure type equivalence class if the input model 

contains structure type definitions

• Named kcg_copy_structname

o For each array type equivalence class if the input model contains 
array type definitions

• Named kcg_copy_arrayname
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KCG_COPY Macro  (C Code)

kcg_types.h:
o If the type is a structure named structname then kcg_copy is 

generated as follows:
#ifndef kcg_copy_structname

#define kcg_copy_structname(kcg_C1 , kcg_C2 ) \

( kcg_assign_struct ( ( kcg_C1 ) , (kcg_C2 ) , sizeof (structname ) ) )

#endif

o If the type is an array named arrayname then kcg_copy is generated 
as follows:

#ifndef kcg_copy_arrayname

#define kcg_copy_arrayname(kcg_C1 , kcg_C2 ) \

( kcg_assign_array ( ( kcg_C1 ) , (kcg_C2 ) , sizeof (arrayname ) ) )

#endif
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KCG_COPY Macro  (C Code)

KCG optimizes the generation of kcg_copy macros

A copy function is mainly generated in the target code when
o An output crosses bottom-up one or several nested nodes (so with 

memories)

o The design assigns a new value from a structured input to a 
structured output
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Context Structure (C Code): reminder

An input context is a structure in the generated C code that 
gathers the inputs of an operator:

o Defined by: typedef struct { inputs } structname;

where structname is the canonical name of the operator with 

prefix inC_

The operator output context is the variables set composed of 
o All its memories, initialization variables and recursively output 

contexts of sub-operators instances

o Depending on code generation options: all outputs, all probes, some 
local variables, all assertions, and variables containing the clock 
value of observable variables

o Defined by: typedef struct { … } structname;

where structname is the canonical name of the operator with 

prefix outC_
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KCG_COPY Macro  (C Code)

Root Node calls N1 node

void N1(ArrayType *Input1, outC_N1_FakeData *outC)

{

/* fby_1_init_1 */ if (outC->init) {

outC->init = kcg_false;

outC->Output1[0] = kcg_true;

outC->Output1[1] = kcg_true;

outC->Output1[2] = kcg_true;

outC->Output1[3] = kcg_true;

}

else {

kcg_copy_ArrayType(&outC->Output1, &outC>rem_Input1);

}

kcg_copy_ArrayType(&outC->rem_Input1, Input1);

}

void Root(inC_Root *inC, outC_Root *outC)

{

N1(&inC->Input1, &outC->Context_1);

kcg_copy_ArrayType(&outC->Output1, &outC->Context_1.Output1);

}

Root.c:

N1.c:

Input1 and Output1: ArrayType = bool^4

Without expansion option
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KCG_COPY Macro  (C Code)

void N2(StrucType *Input2, kcg_bool *Output1, StrucType *Output2)

{

*Output1 = (*Input2).F1 & (*Input2).F2 & (*Input2).F3;

kcg_copy_StrucType(Output2, Input2);

(*Output2).F1 = *Output1;

}

void Root(inC_Root *inC, outC_Root *outC)

{

N2(&inC->Input1, &outC->Output4, &outC->Output5);

}

Root.c:

N2.c:

Input1 and Output2: StrucType = {F1:bool, F2:bool, F3:bool}
Output1: bool

Without expansion option

Root function calls N2 function
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Ada Code Generation Files

The default definitions (predefined types, …) are not 
generated but are contained in

o kcg_config.ads located under 
<installation>\SCADE\include\Ada and 

o Kcg_config.adb located under <installation>\SCADE\lib\Ada

Ada
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Ada Code Generation Files

kcg_types.ads: contains 
o manifest user-defined types as types

o structures for the State Machines as types

<package-path>.ads: Ada specification for non-
imported elements (non-expanded operators)

o Non-manifest Scade types as types

o Constants

o I/Os root operator and sub-operators structures (output contexts) as 
types

o init, reset and cyclic procedures for root and sub-nodes

o Function if the non expanded Scade function is not the root 
operator and returns a single output otherwise a procedure

Ada
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Ada Generated Code: kcg_types.ads

…

Ada
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You can generate additional 

wrapping code or 

build executable code dedicated 

to the environment

Code Integration Options
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Code Integration Options (C Code)

None:
o Embedded code generation

Target:
o Code generation extends 

code for the selected target:

• Simulator, FMU, Mobile, NI Veristand

• Simplorer, Simulink, Standalone 
executable

• Timing and Stack Optimizer or Verifiers

Adaptor:
o Code generation extends code to the selected adaptor (RTOS and 

external tools):

• ASAM MCD-2MC, AUTOSAR, INTEGRITY-178B , MicroC_OS-II, OSEK, PikeOS, 
SCADE Display Co-generation, Test Services API, VxWorks 653, VxWorks CERT     

Not KCG options but SCADE Suite Editor features
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Code Integration Options (C Code)

Other extensions:
o MTC Instrumenter Wrapper:

• Generate KCG 6.4 MTC wrapper code

o MTC Instrumenter Wrapper66:

• Generate KCG 6.6 MTC wrapper code

Periodicity:
o Set the periodicity of code execution 

• From the drop-down list

• Directly from the entered values

Not KCG options but SCADE Suite Editor features
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Code Integration Options (Ada)

None:
o No code extension is produced

Target:
o Code generation extends 

code for the selected target:

• Simulator

Adaptor
o Code generation extends 

code to the selected adaptor:

• Test Services API

Other extensions:
o MTC Instrumenter Wrapper66:

• Generate KCG 6.6 MTC wrapper code

Ada
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SCADE Suite Basics

Traceability
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Brainstorming

Objective: 

Define what requirements traceability is

Requirements:

In a group, share and discuss your opinion and then present 

it to the other groups

Preparation Time: 5 min
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What is requirements traceability?

Requirements…
• Requirements are explicitly defined and identified at different 

levels of the system development 

… Traceability
• Requirements are tracked across the entire design cycle, 

including the iterative phases (evolutions, derivatives, etc.)
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What is requirements traceability?

Stakeholder
Requirements

SW 
Requirements

System
Requirements

Operational analysis
Supports

Traceability
Allocations

System functions

System architecture Supports

Traceability

(detailed 
interfaces)

Traceability
Synchronization

Design

Traceability
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What is requirements traceability?

Initial investment…
• Requirements standards definition

• Information added to files according to standards

• Requirements management tool

… with great benefits
• Improves project members and stakeholders relationship

• Provides management visibility and support for decision making

• Enables fast maturity of specifications

• Saves time to evaluate impact of changes
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What is requirements traceability?

« How do you implement this requirement…? »

« If I change something in my design, what’s the impact…? »

Specs

Design

Code

Tests...

« If I change something in my implementation, what about the 
regression…? »
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What is Requirements Traceability?

Requirements Traceability is mandatory in Aeronautics (DO-
178C for Software, DO-254 for Hardware):

Requirements Traceability is required as well by the EN 
50128 standard for Rail Transportation software:

Whatever is the solution used for requirements, the need for 
traceability with project workbenches and authoring tools is 
always present.

Table A-3 Objective

6
High-level requirements are traceable 

to system requirements

Table A-4 Objective

6
Low-level-requirements are traceable to 

high-level requirements

Table A-5 Objective

5
Source code is traceable to low-level 

requirements
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What is Requirements Traceability?

For the automotive industry, ISO 26262 indicates:

Part 6, 7.4.2 During the development of the software 
architectural design the following shall be considered:

a) the verifiability of the software architectural design

=> This implies bi-directional traceability between the 
software architectural design and the software safety

requirements
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Application Lifecycle Management Gateway 

SCADE LifeCycle Application Lifecycle Management Gateway 
(ALM) extends SCADE Suite with ALM tool connection
capabilities:

o Connects to ALM tools like DOORS or Reqtify

o Provides a complete traceability solution for the model design 
process in ALM tool environments
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Traceability applied to a SCADE Model

Requirements 
automatically 
captured from 
DOORS or textual 
documents,…

Traceability is done 
while doing the SW 
development work.

Traceability analysis 
is always up to date.

SCADE
ALM
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Launch the ALM tool: 
o Select the SCADE menu Project > ALM Gateway or click on the ALM 

tool toolbar:

o Select ALM tool (if need be)

ALM Tool Selection
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ALM Tool General Settings

Option Description

Reset ALM Gateway 
Project 

Remove the ALM Gateway project from the SCADE project to 
allow defining another ALM connection
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Add the coverage of requirements:
o Select a Scade object in the Scade view
o From the Requirements Docking Window 

o Select a requirement in the available list

o Click on Create Link

Remove the coverage of requirements:
o From the Requirements Docking Window 

o Select an element in the covered objects list 
o Click on Remove Link

Perform Requirements Traceability

2

3

1
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Create Requirements Traceability

Traceability links of the selected Scade object are displayed 
in the Traceability tab of the Properties window (empty if no 
requirements coverage)

From the Properties window
• Remove a covered requirement

• Select it in the Requirements list 
• Click on Remove Link
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SCADE Suite Basics

Automated Documentation Generation
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SCADE LifeCycle Reporter

Automated documentation generation enables:
o Review of the SCADE Suite model

• Verification that the SCADE design conforms to project standards

• Verification that the SCADE design complies with requirements (in 
addition to simulation results)

o Communication to other teams

o Constitution of the dossier to be build up for certification
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Reporter: General Settings

Generate project reports using predefined configurations 
(HTML or RTF) or user configurations

Use the toolbar to open the Settings dialog:

Content of the report
o Two formats : HTML or RTF 

o Choose  a TCL script to generate a content fully customizable 

• A default one is available: ScadeReport.tcl
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Reporter: Structure Settings

Customization of the structure: 
o Call graph, table of content, etc.
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Reporter: Structure Settings

Easy management of the headers/footers
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Display Options

Constants:
o Three possible representations :

As Arrays

As Images As Text
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Custom Attributes

Manage document attributes:
o Classification, distribution list, etc.

Customize cover, structure, description from project 
properties or from the Reporter settings



89 © 2016 ANSYS, Inc. February 1, 2017 ANSYS Confidential

SCADE Display Integration

When there is at least one SCADE Display specification in the 
project or one operator connected to a specification

SCADE display co-report:

o Complete: generate the "SCADE Display Integration” section in the 
“Software Architecture” chapter, the connection table for each 
connected operator and SCADE Display reports

o Connection Tables: same as “Complete”, without the generation of 
the SCADE Display reports

o None: no report of SCADE Display elements
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Report generation

After having selected a configuration, to produce a report, 
click on: 

A HTLM or RTF document is displayed, according to the 
selected format

o Contains the current SCADE design loaded in SCADE Suite 



91 © 2016 ANSYS, Inc. February 1, 2017 ANSYS Confidential

SCADE Architect Model

In the same way, report the system design (in SCADE 
Architect) that is synchronized with the SCADE Suite model 
such as the software architecture model
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Report Document
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Report Document
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Qualified Verification Tool

SCADE LifeCycle Reporter is qualified as a verification tool, to 
ensure that , in any cases, what is printed represents the 
model:

o Certification Kit DO-178C Level A (Criteria 3 / TQL-5) 

o Qualified for SCADE Suite and SCADE Display

o Qualified report generation only in batch mode 

o Qualified tool for the RTF format (forced option) and a defined 
environment: 

• Use the required “Reporter\ScadeQualifiedReport.tcl” script

• A dedicated reporter configuration named “Qualified Reporter” is 
available
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Qualified Verification Tool

In the scope of the qualification, several “standard” reporter 
properties values are forced, as follows:

Reporter property Forced value Reporter GUI tab Reporter GUI field name

ImagesInLineWithText true (default) Structure In-line images

ReportHeaderAndFooter true (default) Structure Generate Headers/Footers

ReportStructure true (default) Structure Generate cover, TOC, and first 
section

AllowRowToBreak true Display Allow row to break across page

cstDisplayType Flat Display Constants representation:
…as Text

DisplayCalledAndCalling true Display Display called and calling operators 
sections

DisplayKCGPragma true Display Display KCG Pragma
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Batch Generation

SCADE –report <project> -configuration <configuration> 

Notes:  

• <project> = “project name”.etp

• To call the qualified reporter, the “reporter script” 
property must be set to 
“Reporter\ScadeQualifiedReport.tcl” in the configuration
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Advanced TCL Customization

SCADE LifeCycle Reporter can be customized with TCL scripts:
o Use the Reporter-related TCL commands to set the content and 

display of model documentation and reports (refer to details in the 
User Manual document)

The customization script files must be registered in the 
SCADE Suite environment for a proper evaluation

Use this tool with the user customized TCL procedures (or 
options outside the qualification context)

Additional verification activities are required
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Exercise 3: Cruise Control

Generate report documents with different options and 
observe the generated files:

First format : HTML 
Constant representation: As Arrays

Generate a table of content

Second format: RTF 
Constant representation:  As Images

Do not generate a table of content

Time: 10 min
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SCADE Combined Testing Process
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What is SCADE Combined Testing Process?

SCADE Combined Testing Process is a SCADE Model-Based
approach for combining efficient and rigorous testing
activities

Objectives are the following:
o Optimize the Testing effort

o Maximize the benefit from KCG qualification/certification 

Combination is the following:
o Software Requirements-Based Testing

o Low-level Testing on a sample

o Testing on host and on target
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“Traditional” Testing Process

An Embedded Application is typically made of:

o A scheduler or an Operating System + Drivers for Inputs and Outputs

o The code of the Application 

o Libraries of some elementary operations (C, and Ada code) that are 
repeatedly used in the application

Application 
Code

Libraries

Application 
Code

Scheduler and I/O
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“Traditional” Testing Process

Low-Level Testing (a.k.a. Unit Testing) is applied to the 3 components of the 
application

Low-level Testing of the Application Code is time consuming, requires updates 
each time there is a code update (which is a standard situation), and the stopping 
criterion is not easy to establish

Application 
Code

Libraries

Application 
Code

Scheduler and I/O

Low-Level Tests

Low-Level Tests

Low-Level Tests
Stable

Stable

Massive, many updates
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“Traditional” Testing Process

The Requirements-Based Tests are coded in C, Ada and/or in a specific Target 
Test Tool format, and run on target; thus, they are debugged on target

Target Test Tool Structural Coverage measurement can be the stopping criterion, 
generally mixed with low-level test coverage scores, sometimes not easy to 
justify

Requirements-
Based Tests 

Application 
Code

Libraries

Application 
Code

Scheduler and I/O

Low-Level Tests

Low-Level Tests

Low-Level Tests
Stable

Stable

Massive, many updates

On Target
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SCADE Combined Testing Process (CTP)

An Embedded Application designed with SCADE Suite is typically made of:

o A scheduler or an Operating System + Drivers for Inputs and Outputs

o The code of the Application, generated by SCADE Suite KCG

o Libraries of some elementary imported operators that are repeatedly called in the 
SCADE model (SCADE libraries are part of the generated code)

Application 
Code

Libraries
(C code)

SCADE
Generated

Application Code

Scheduler and I/O
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SCADE Combined Testing Process (CTP)

Application 
Code

Libraries
(C code)

SCADE
Generated

Application Code

Scheduler and I/O

Low-Level Tests

Low-Level Tests
Stable

Stable

No change in Low-level Testing against the Scheduler and I/O (or OS) 
and against the Libraries of C Code 
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SCADE Combined Testing Process (CTP)

The Requirements-Based Tests are created using SCADE Test Environment and 
run on Host (SCADE Simulation) and/or on Target (Target Testing) according to 
the Test Strategy that has been established

SCADE Model Coverage is the unique means to monitor and stop the 
Requirements-Based Testing activities

Application 
Code

Libraries
(C code)

SCADE
Generated

Application Code

Scheduler and I/O

Low-Level Tests

Low-Level Tests
Stable

Stable

Model Coverage
(assessed with
SCADE Model Coverage)

Requirements-
Based Tests 

with SCADE Test 
Environment

On Host and/or on Target
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SCADE Combined Testing Process (CTP – C Code)

Application 
Code

Libraries
(C code)

SCADE
Generated

Application Code

Scheduler and I/O

Low-Level Tests

Low-Level Tests
Stable

Stable

CVK BricksLow-Level Tests
Stable

On Host and/or on Target

SCADE Suite CVK is a Low-Level Test Suite used to perform unit testing on target of all the 
C constructs that may be used in the SCADE Generated Application Code

Requirements-
Based Tests 

with SCADE Test 
Environment

Model Coverage
(assessed with
SCADE Model Coverage)

CVK is available for C only
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SCADE Compiler Verification Kit (Overview)
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Combined Testing Process & CVK

User Development Project (SCADE Suite)

KCG
Cross-

CompilerC code
Object 
code

Integrate KCG 
in the 

Certification process

Verify Cross-Compiler

using CVK

KCG
Certification
Kit

Compiler
Verification

Kit

User Environment

Low-level Testing on 
Target is cancelled only
if:

• The Code Generator
is qualified/certified
 KCG is
qualified/certified

• A formal sample of 
KCG generated code 
is cross-compiled and 
tested on target
 CVK is a suite of tests 
dedicated to compiler 
verification
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Compiler Verification Kit (CVK)

CVK is a test suite whose purpose is to verify that a

compiler correctly compiles code generated by

SCADE Suite KCG

CVK has been developed for the verification of a

development environment containing KCG

CVK does not validate the C compiler or processor

CVK is not an executable software and not a tool
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The CVK Workflow
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Annexes



114 © 2016 ANSYS, Inc. February 1, 2017 ANSYS Confidential

Simulator
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How do Software engineers 

debug a SCADE Suite design to 

resolve a defect?

How do Software engineers 

simulate a SCADE Suite design to 

check its behavior?
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Simulator Main Features

SCADE Suite Simulator enables the simulation and debugging 
of SCADE Suite models by executing code which is generated 
by Code Generator SCADE Suite 

Editor

SCADE Suite 
Code Generator

SCADE  Suite 
Simulator

Input Vectors

SCADE Suite Simulator
Graphical Interface

Scenarios

Command Line 
Input

Output Vectors

Standard Output

SCADE 
Description

cyclic function

Simulation 
Executable
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Simulation Precision: Real Values

Possible to modify the format to display and store real values:

o Right-click on the project file in Scade View and select Properties Simulation 
tab

o From the Format field: select scientific, decimal, or shortest to set the real 
numbers display

o From the Significant digits field: set the number of significant digits 

• An integer between 1 and 17 (by default this number is 5)

Note: In the Port Number field, set the port for the co-simulation mode 
with an external application (by default 64064)
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Simulator Interface 

Select the operator to simulate from Scade View:

From Code Generator toolbar:
o Select the “Simulation” configuration

o Build the simulation binary
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Simulator Interface

Look under the “Info Log” and “Build” tab if the simulation 
build is completed:

Launch the simulation:
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Simulator Interface

Scade

User inputs

Updated 
variables

User inputs &
Watch list 
variables

Graph: Timing
Diagrams

Scenario file handlingPlay buttons
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Simulator Toolbar

Step

Cycles per step

Continuous play

Reset simulation

Stop simulation

See/Hide simulation window

See/Hide watch window

See/Hide graph window

Pause

Fast Step

Fast Back

Back
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Set Input Values 

To assign values to the model’s inputs for each cycle :

Click on the input (or press F2) into the 
Instances tab and set the new value.
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Simulation Window

Menu: View >Docking Windows >Simulation

Simulation toolbar button: 

Customizable refresh rate in numbers 
of ticks to speed up simulation 

Cycle delay in 
continuous mode 

Current cycle. 
Change = Go to

Simulation actions 
history

Number of ticks/s in 
continuous mode
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Watch Window

Menu: View >Docking Windows >Watch

Simulation toolbar button: 
o Drag & drop the variables to watch from the

Instances browser or

o Use the variable contextual menu or

o Use the command Simulation – Watch List Add - Instance Path

Use DEL to remove a variable from the view
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Graph Window

Menu: View >Docking Windows >Graph

Simulation toolbar button: 
• Drag & drop variables to view from the:

‒ Instance view / instance net view or

‒ Watch window (work also on a 
selected field a structured value) or

‒ Use the variable contextual menu.

Use DEL to remove a variable from the view

Graph settings in menu Tools > Options, Simulator tab

Copy graphs into the clipboard to paste into others 
applications
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Graph Window

Menu: Tools >Options >Simulator

Display options:
o Check Enable colored graphs to display colored lines in the Graph 

window

o In the Graph sampling interval field, specify the sampling interval 
(per tick) of the graphs during continuous or multiple step 
simulation

o In Graph visible values field, set the number of values displayable in 
the Graph window
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AGENDA

Integrated Development Environment

Batch Mode
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Simulation in Batch Mode

Simulation can be used in batch mode:
o This can be useful to launch several tests in a row and get back the 

output files later

The first step is to generate the simulation executable for the 
node to simulate:

o Using the “classic” way, by pressing build          from the editor

o Using the batch mode, with the following command:
SCADE -code <project.etp> -sim -conf <configuration>

Both actions generate the simulation executable and dynamic library 
named after the simulated node (i.e. respectively <root_node>.exe and 
<root_node>.dll) in the <target_dir> directory specified in 
<configuration>
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Simulation in Batch Mode

Second step is to launch the batch execution of the 
simulation executable:

<SCADE installdir>/bin/scssmlnc.exe <root_node>.dll
[-scenario <filename.(sss|in|sts)>] [-out 

<filename.(out|csv)>] [-obs <filename.obs>]

Depending on the options used when launching simulation, 
the behavior will be different
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Simulation in Batch Mode

Full Batch Mode
o This mode runs simulation sessions driven by the SCADE Suite 

Simulator inputs’ scenarios (input vector scenarios, TCL scenarios, 
or state scenarios) without any human intervention

o The outputs for successive simulation cycles are produced in a file 
by the  –out option

o Simulation cycles are computed from the values of the input 
scenario file that must be specified by the –scenario option
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Simulation in Batch Mode

Interactive Command Line Mode:
o This mode allows to launch any SCADE Suite Simulator feature using 

simulation TCL command lines

o The mode lets you interact directly with the simulation executable: 
you enter commands on the prompt and the executable displays 
computed results

o This is the default mode when the –out option is not used
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Simulation in Batch Mode

Options:
o -scenario:

Load all kind of scenarios as discriminated by their file extension 
(.sts, .sss, or .in) Can specify a list of paths to heterogeneous 
scenario files separated by a space The specified scenarios are 
played consecutively in the order of the list

o -out:
Specify the output file where the simulation results are saved. Use 
this option to run the simulation in “Full Batch Mode”

o -obs:
This option specifies the name of a file containing a list of variables 
that must be added to the variables saved in the output file
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Imported Code
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I know how to import a C or Ada function 

in a SCADE Suite design

Imported Code: I Know!!!
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How to import constants 

and types from legacy 

code?

How to simulate with 

imported code?

What Else?
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Externally defined user types 

can be introduced 

in SCADE Suite models 

as imported types

Imported Types (C Code)

You must provide the definition of imported types 

in header files that contain definitions relative to: 
• the imported type

• the initialization macro named kcg_init_<type name>

• the copy macro named kcg_copy_<type name>

• the comparison macro named kcg_comp_<type name> 

Only imported operators 

can modify the data of 

imported typed flows
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C Imported Types

Pair imported type defined in Pair.h into the Package1 
package:

#ifndef PAIR_H
#define PAIR_H

typedef struct{
int8 C1;
int8 C2;

} Pair_Package1;

#define Pair_init_Package1(pTo) { \
(pTo)->C1=0; \
(pTo)->C2=0; \

}

#define kcg_copy_Pair_Package1(pTo,pFrom) { \
(pTo)->C1 = (pFrom)->C1; \
(pTo)->C2 = (pFrom)->C2; \

}

#define kcg_comp_Pair_Package1(x, y)   ( ( (x)->C1==(y)->C1 &&  (x)->C2==(y)->C2)?kcg_true:kcg_false) 
#endif

The imported type definition

The initialization macro definition 

The copy macro definition  

The comparison macro definition
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Externally defined user 

types can be introduced 

in SCADE Suite models 

as imported types

Imported Types (Ada)

Must provide the definition of imported types in 

specification files containing definitions relative to:
• the imported type

• the initialization value

Only imported operators 

can modify the data of 

imported typed flows

Ada
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Ada Imported Types

Pair, imported type defined into the Pimp package:

package Pimp
-- Pimp::
is

-- Pimp::Pair/
type Pair is record;

C1: Kcg_Config.Kcg_Int8;
C2: Kcg_Config.Kcg_Int8: 

end record;

--- initial value to be provided
Pair_init : constant Pair := Pair' (C1 => 28, C2 => 28);

end Pimp;

The imported type definition

The initialization definition 

Ada



142 © 2016 ANSYS, Inc. February 1, 2017 ANSYS Confidential

Imported Types

To set an imported type:
o Create a new type in a package or at the model level from Scade

View

o Write the required definition(s) in the header file

Specify <imported> in Type View 
or 
Check Imported in the selected 
type Properties

Specify the header definition file      
(for simulation purpose)
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Users must define conversion and 

comparison functions 

used in the simulation mode 

for imported types to simulate the model 

(see user manual for details)

Imported Types
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Imported Types

When initializer pragma is attached to an imported type, the 
initialization function of the associated type is named 
according to the pragma definition 

If an imported type has no pragma, the default name 
<type_name>_init is used
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C Imported Types

When an initializer pragma is attached to an imported type 
named Pair, exactly the field name is used as identifier for 
the initialization function of the associated C type. Without 
pragma, «Pair_init» is generated in the model initialization 
function.

void Operator1_init(outC_Operator1 *outC)

{

outC->O_Bool = kcg_true;

Initializer(&outC->O_GBPair);

ImpNode_init(&outC->Context_1);

}

void Operator1_init(outC_Operator1 *outC)

{

outC->O_Bool = kcg_true;

Pair_init(&outC->O_GBPair);

ImpNode_init(&outC->Context_1);

}
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Ada Imported Types

When an initializer pragma is attached to an imported type 
named Pair, exactly the field name is used as identifier for 
the initialization function of the associated C type. Without 
pragma, « Pair_init » is generated in the model initialization 
function

package Pimp
….
--- initial value to be provided
Pair_init : constant Pair := Pair' (C1 => 28, C2 => 28);

end Pimp;

package Pimp
….
--- initial value to be provided

Initializer : constant Pair := Pair' (C1 => 28, C2 => 28);

end Pimp;

Ada
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Imported Constants

Externally defined user constants can be introduced in SCADE 
Suite models as imported constants

Constants can be typed with Scade types or imported types

Select Imported in the 
Declaration tab of 

constant Properties
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C Imported Constants

Provide the value of the constant in a C file (according to the 
option with or without KCG Pragma Const):

o Constants typed  with Scade types

o Const int8 constant1 = 7; 

o Constants typed with imported types

o Const Pair_Package1 Constant1_Package1 = {1, 2};
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C Imported Constants and Simulation

For the simulation mode, insert the definition file in the 
project:

o In FileView, select the project, right-click, and select Insert >Files 

Open the Properties window and specify its type:

For operators and types: this action is not mandatory for files 
already imported through the Properties
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Ada Imported Constants

Provide the value of the constant in .ads file (according to the 
option with or without KCG Pragma Const):

Constants typed with Scade types:

o Constant1 :  constant Kcg_Config.Kcg_Int32 := 7; 

Constants typed with imported types:

o Constant1 : constant Pimp.Pair := (0, 1);

Ada
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Ada Imported Constants and Simulation

For the simulation mode, insert the specification file in the project:

o In FileView, select the project, right-click, and select Insert > Files 

Open the Properties window and specify its type:

For operators and types: this action is not mandatory for files already 
imported through the Properties

Ada
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Imported Operators

To implement in the host language operators not suited for 
SCADE Suite modelling or already existing such as legacy 
code.

Right-click on Operators folder in Scade View and select:

Insert > Imported Operator

Operators can be a function or a node (with memory)
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Imported Operators

The operator’s name and interface are defined in SCADE 
Suite.

Its body is defined in the host language.

It graphically appears as a box with a vertical bar on the left 
hand side.
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Imported Operators: Functions

Outputs only depend on inputs:

kcg_float32 ImpCOS(kcg_float32 Input1,kcg_float32 Input2)

{

kcg_float32 Output1;

Output1 = cos(Input1 + Input2);

return Output1;

}
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C Imported Function Implementation

KCG generates a kcg_imported_functions.h file containing 
the function prototypes for the imported function operators:

#ifndef ImpCOS
/* ImpCOS */
extern kcg_float32 ImpCOS(
/* ImpCOS::Input1 */ kcg_float32 Input1,
/* ImpCOS::Input2 */ kcg_float32 Input2);

#endif /* ImpCOS */
#endif

In the Properties window, specify the name of the source file 
for the simulation purpose (or add it in the project)
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Imported Operators: Functions (Ada)

The output only depends on inputs:

function ImpCOS(

Input1 : in Kcg_Config.Kcg_Float32;

Input2 : in Kcg_Config.Kcg_Float32) return Kcg_Config.Kcg_Float32

is

Output1: Kcg_Config.Kcg_Float32;

begin

Output1:= cos(Input1 + Input2);

return Output1;

end ImpCOS;

Ada
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Ada Imported Function Implementation

KCG generates a template of specification (.dads) and bodies 
(.dadb) files for the imported function operators:

o In the Properties window, specify the name of the source file for the 
simulation purpose (or add it in the project)

package Pimp
-- Pimp::
is

-- Pimp::ImpCOS/
function ImpCOS(

-- Input1/
Input1 : in Kcg_Config.Kcg_Float32;
-- Input2/
Input2 : in Kcg_Config.Kcg_Float32) return 

Kcg_Config.Kcg_Float32;
end Pimp;

function ImpCOS(
-- Input1/
Input1 : in Kcg_Config.Kcg_Float32;

-- Input2/
Input2 : in Kcg_Config.Kcg_Float32) return Kcg_Config.Kcg_Float32

is
Output1 : Kcg_Config.Kcg_Float32;
begin

-- The body of this function must be provided
null;
return Output1;

end ImpCOS;

Ada
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AGENDA

Imported Types

Imported Constants

Imported Function

Imported Nodes
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Imported Operators: Nodes

Outputs depend on inputs and internal states

Enable multiple instances

Are reset-able

Called in following the data flow order

void ImpNode(kcg_real Input2, outC_ImpNode *outC)
{

outC->Output2 = cos(Input1) + 20.0;
}
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C Imported Node Implementation

For each imported node, name_<path>, two template files 
are generated:

o name_<path>.dh: contains the template declarations of:

• The reset function:  name_reset_<path>() and

• The initialization function: name_init_<path>()

• The cyclic function:  name_<path>()

• The context structure of the C functions

o name_<path>.dc: contains the template definitions of the C 
functions: 

name_reset_<path>(), name_<path>() and name_init_<path>())

o Users provide the initialization, reset and cyclic functions for 
imported nodes

Note:  <path> corresponds to the package hierarchy leading 
to the operator
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C Imported Node Implementation: Header

Copy the header template in name_<path>.h

Fill the context structure adding the initialization and 
memory fields ()

typedef struct {
/* --------------------------- outputs  --------------------------- */
kcg_float32 /* ImpNode::Output1 */ Output1;
/* ------------- insert eventual inits and memories  -------------- */
kcg_bool init;

} outC_ImpNode;
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C Imported Node Implementation: Body 

Copy the body template in name_<path>.c

Fill the function bodies:
void ImpNode_init(outC_ImpNode *outC)
{
/* The body of this function must be provided */
outC->init= kcg_true;
outC->Output1 = 0.0;

}

void ImpNode(/* ImpNode::Input1 */ kcg_float32 Input1, outC_ImpNode *outC)
{
/* The body of this function must be provided */
if (outC->init)
{
outC->init= kcg_false;
outC->Output1 = 0.0;
}
else
{
outC->Output1 = cos(Input1) + 20.0;
}
}
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C Imported Node Implementation

Specify the created C file in the properties of the SCADE Suite 
imported operator for simulation purposes:
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Change Default Mapping to C External Code

The default mapping between the generated code and the 
external code can be changed in two ways:

o Add a KCG pragma name to change the name of the C symbol used 
in the generated code: ImpNode()

o Define a new mapping using a macro in a user macro file: ExtFct()

KCG 
Generated 

C code

Manual C 
code for 
imported 
Operators

Default external object mapping
Kcg_imported_functions.h
OpName_<path>.dh

User external object mapping
User_macro.h:

#define ImpNode() ExtFct()

Files use symbols 
for external C 
functions
Ex. ImpNode()

Files contain 
declarations and 
implementation for C 
functions
Ex. ImpNode() or 
ExtFct()
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Imported Operators: Nodes (Ada)

Outputs depend on inputs and internal states

Enable multiple instances

Are reset-able

procedure ImpNode(Input2 : in Kcg_Config.Kcg_Float32;
Ctx : in out Context_ImpNode)

is
begin
Ctx.Output2 := cos(Input2) + 20.0;
end ImpNode;

Ada
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Ada Imported Node Implementation

KCG generates a template of specification (.dads) and bodies 
(.dadb) files for the imported nodes (separate files for reset, 
init and cyclic procedures)

package Pimp
Is
….
procedure ImpNode_Reset(Ctx : in out Context_ImpNode);
procedure ImpNode_Init(Ctx : out Context_ImpNode);
procedure ImpNode(Input1 : in Kcg_Config.Kcg_Float32; Ctx : 
in out Context_ImpNode);

end Pimp;

procedure ImpNode_Init(
Ctx : out Context_ImpNode)

is
begin

-- The body of this function must be provided
null;

end ImpNode_Init;

procedure ImpNode(
-- Input1/
Input1 : in Kcg_Config.Kcg_Float32;
Ctx : in out Context_ImpNode)

is
begin

-- The body of this function must be provided
null;

end ImpNode;

procedure ImpNode_Reset(
Ctx : in out Context_ImpNode)

is
begin

-- The body of this function must be provided
null;

end ImpNode_Reset;

Ada
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Ada Imported Node Implementation

In the Properties window, specify the name of the source file 
for simulation purposes (or add it in the project)

Ada
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Introduction to Best Practices
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Engineering Best Practices With the Help of the 
SCADE Toolset

Day 4 presents a menu to related tools, processes and concepts.

It leads to other training materials and voluntarily open discussion to 
other topics.

Should you need more information on any of the presented items, 
please request the necessary training courses

http://www.esterel-technologies.com/files/Trainings/SCADE-Suite/Click-Here-for-Instructions.html
http://www.esterel-technologies.com/files/Trainings/SCADE-Suite/Click-Here-for-Instructions.html
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Basic Trainings

SCADE Basic Trainings present the methodology, language and tools 
usage according to the steps of a software development process. 

They are meant for beginners with no prior, or little experience of the 
SCADE products and environment.

The Basic Trainings are composed of different modules presenting the 
modeling activity using SCADE Suite, SCADE Display, SCADE Architect,
SCADE Test, and SCADE Solutions for ARINC 661

Proposed trainings are:

o Model-Based Systems Engineering with SCADE Architect

o Model-Based Design with SCADE Display

o Testing SCADE Suite Applications with SCADE Test

o Testing SCADE Display applications with SCADE Test

o Model-Based Virtual Prototyping with SCADE Test Rapid Prototyper

o Model-Based Design of ARINC 661 Compliant Cockpit Display 
Systems with SCADE Solutions for ARINC 661
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Advanced Trainings

SCADE Advanced Training focus on SCADE solutions and best 
practices. They combine your experience to ours to make 
you become an expert. 

Advanced training courses are ideal for SCADE users who 
already have an understanding and some experience in using 
the SCADE tools:

o Optimize your SCADE Suite Models and Code Performance

o Optimize your SCADE Display Models, Code and Integration 
Performance

o Extend the SCADE Suite Capabilities using TCL Scripts

o SCADE Suite Modeling with Import of Simulink/Stateflow® Models

o Model-based Formal Verification with SCADE Suite Design Verifier

o SCADE Architect Configurator 

o SCADE Avionics Package / SCADE Automotive Package
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Process Trainings

They provide key insights on how to comply with the specific 
requirements of the certification standards and aim at 
sharing our expertise and experience in system and software 
engineering processes. 

They support you in implementing quickly and efficiently 
your projects and reaching your objectives.

o Effectively Manage a DO-178C (or DO-178B) Certified Model-Based 
Project with SCADE

o Optimize Verification and Validation Strategies for DO-178C (or 
DO-178B) Compliant Applications using SCADE

o Transition to DO-178C

o SCADE Model-Based Systems Engineering of ARP-4754A Compliant 
Aeronautics Systems

o Realization of a Railway Application Compliant with the EN 
50128:2011 Standard with SCADE
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Online Introduction Trainings

On the YouTube ANSYS How To channel, you will find 
introduction videos on the complete SCADE toolset. 

Entry level information for the safety critical industry-related 
standards is provided, as well as SCADE best-practices to 
follow them and take the tools as a support on implementing 
a compliant methodology.

For more advanced users, tips and tricks videos demonstrate 
the use of the tools on industry-based examples by our 
experts.

Come follow us on YouTube!

https://www.youtube.com/channel/UCdymxOTZSP8RzRgFT8kpYpA
https://www.youtube.com/channel/UCdymxOTZSP8RzRgFT8kpYpA
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